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Abstract

The field of wireless communication has become an important part of electrical engineering
undergraduate program. Due to developments in this field there is an increasing need for
graduates with good understanding of wireless channels. However, the electromagnetic fields
and radio propagation has been regarded as a dry and abstract field, due to difficulty of
integrating tangible and realistic experiments into electrical engineering curriculum. Sometimes
setting up a laboratory for these experiments could be very expensive. Therefore, a lot of time
using simulation tools is a good alternative to examine and visualize the realistic problems.
However, the available simulation software may require vast technical proficiency, which
sometime impedes the inclination of students towards this area of study.

In this paper we introduce a ray-tracing simulation tool that can be beneficial in teaching wave
propagation and wireless communication. Wireless InSite®, from Remcom®), is a site-specific
wireless channel simulation tool based on ray-tracing method. This paper introduces various
feature of Wireless InSite such as how to import site-specific information from Google Maps,
create three dimensional object files and manipulate them for creating a realistic environment,
how to select different types of antennas and waveforms. Then an example is given and the step-
by-step problem setting, execution and analysis of results are explained. This example or similar
ones may be utilized as a laboratory assignment in the related curriculum.

Introduction

When it comes to wireless or electromagnetic communication, the challenge has always been to
calculate and measure the parameters associated with it. The development in Computational
Electromagnetics (CEM) has yielded different numerical techniques and methodologies to model
the electromagnetic phenomenon and wireless channels on mathematical formulations of
Maxwell’s equations. These include numerical methods such as Method of Moments', Finite
Difference Time Domain” and Finite Element Method®. While these methods are very helpful in
design and analysis of small antennas and microwave circuits, they are computationally very
intense for large objects. Geometric Optics (GO) and Geometrical Theory of Diffraction (GTD)
which is the bases of ray tracing method are computationally less expensive and are often used to
study large wireless systems*”°. Wireless InSite® (WI) from Remcom®’ is a powerful
electromagnetic ray tracing tool for predicting the effects of surroundings such as buildings and
terrain on the propagation of electromagnetic waves. It predicts how the locations of the
transmitters and receivers within an area affect signal strength. WI models the physical
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characteristics if the rough terrain and urban building features, performs the electromagnetic
calculations, and then evaluates the signal propagation characteristics. W1 is also helpful in
carrying out electromagnetic field estimation on urban environments. WI makes these
calculations by shooting rays from the transmitters, and following the propagation path through
the defined environment. While passing through a medium of varying dielectric constant or
index of refraction, electromagnetic waves exhibit a varying function of path’. These rays from
different paths interact with environmental features and make their way to receiver. Interaction
includes:

Reflection off the ground

Reflection off the surface of a building face
Diffraction off of an edge of a building
Transmission through a wall

The software uses advanced high-frequency electromagnetic methods to provide accurate results
over a frequency range from approximately 50 MHz to 40 GHz. In this paper, we have presented
the ray tracing software with a unique approach to attract the student by giving a wholesome idea
of designing and running a project in WI. Wireless Ray Tracing Education Land (WRTEL)®,
Urbana™ 3-D Wireless Toolkit”'’, SE-RAY-EM'""'"? are a few examples of many ray-tracing
simulation software which has different features and advantages but serve the same purpose of
taking the CEM to a level of user-friendly applications.

1. Overview of Wireless InSite (WI)

A brief idea of different WI windows is very handy in understanding the software and gives an
edge over useless rambling over the help menu to figure out its functionality. Here are some of
the WI windows that are used frequently throughout the process of simulation’.

1.1 Main Window

Main window appears when the application is first started. Main window consists of all the
options that would help to navigate through this software, and therefore, it is regarded as the
“parent” window. This window consists of four different menu options: Project, Edit, View and
Help. All these options facilitate the user to get things done. There are alternative ways to access
and modify the data in the program which we will be explained in Section 2 of this paper. In Fig.
1, “Main” window is shown that has different tabs (these are the short-cuts to access/edit the
data). Also, in Fig. 1, “Features” tab is selected and is empty. This is the case when you start the
program for the very first time. Other available tabs are: Images, Study areas, Transmitters,
Receivers, Comm. systems, Materials, Antennas, Waveforms, Requested output, Output, and
Output feature. Each one of these options will be briefly described in the following section.
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Project Edit View Help
D-Z-H R QR " & &
I ﬂ' Features .I Images | <% Study areas ')i(‘ Transmitters '”I Receivers ?1‘; Comm. systems ::: Materials @ Antennas | [\/} Wavefoms | ¥ Requestedoutput | w Output | Y Output fiters
Active | Type | Description |
Selection: Untitled Project [Project] ¥

Fig. 1. Main window of Wireless InSite

1.1.1 Features

As shown in Fig. 2, this is how Features tab looks like when you set up your project. Typically, it
consists of all the imported or built buildings, terrains, objects and city files in the project. The
items listed can be edited, modified or even deleted by simply right-clicking on the particular
row. There are many other options once you right-click on them like rotating, scaling, translating
the item as per the requirement.

Project Edit View Help

D-E-H R OFE" ™ 8| &

|-|1' Features ] Images < Study areas ':‘ii' Transmitters ‘”] Receivers :l?; Comm. systems .::j Materials @‘ Antennas M Waveforms [V Requested output = Output E Output fiters
Active | Type [ Descrption [ System | Longitude [ Latitude [ Zone [ Fiename [
Yes Temain Untitled Temain Cartesian w 0° 0" 0.000" S 0° 0" 0.000" N/A C:\Users\atmel\Desktop\Trial for ASEE\Tr...
Yes Object Babcockhall Cartesian w 0° 0" 0.000" S 0° 0" 0.000" N/A C:\Users\atmel\Desktop\Trial for ASEE\Tr...
Yes Object Upsonll_Hamingtom Cartesian W 0° 0 0.000" S 0° 0" 0.000" N/A C:\Users\atmel\Desktop\Trial for ASEE\TT...
Yes Object Gillete Cartesian W 0° 0" 0.000" S 0° 0" 0.000" N/A C:\Users\atmel\Desktop\Trial for ASEE\TT.
Yes Object Untitled Model Cartesian W 0" 0" 0.000" S 0° 0" 0.000" N/A C:\Users'\atmel\Desktop\Trial for ASEE\TF.
Yes City xPontiac38 Cartesian E 0° 0" 12867" N 0° 0" 11.335" N/A C:\Users'\atme!\Desktop\Trial for ASEE\TF.
Yes City tx Pontiac98 Cartesian W 0" 0" 0.000" S 0° 0" 0.000" N/A C:\Users'\atme!\Desktop\Trial for ASEE\TF...

Ready. Y

Fig. 2. Features window with different data and its descriptions

1.1.2 Images

Images tab consist of the entire image file (JPEG, TIFF, geoTIFF, etc.) imported to the project.
There is, however, a set of steps required for importing an image into WI which is discussed in
Section 2.1 of this paper.

1.1.3 Study areas
Once you have modeled a virtual three dimensional (3D) environment (which will be explained

in Section 2), WI provides the flexibility of selecting different regions (areas) within that
environment where you want to run your desired calculations. This helps us to limit all
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computations to buildings, terrains, transmitters (TX) and receivers (RX) locations within the
study area. The study areas, therefore, consists of different areas (if applicable). This plays an
important role when the modeled environment is fairly big. In addition, right-clicking on study
area provides an option to select between different propagation models, namely free space
model, Hata model, Walfisch-Iikegami model, etc.

1.1.4 Transmitters

Transmitters are primarily placed in a project window (Section 1.3) where the environment is
modeled. Any number of transmitters being placed inside the modeled environment is
automatically updated in the Transmitters tab as shown in Fig. 3. The importance of listing all
transmitters in this tab is that you can manipulate the locations and features of each transmitter
according to the requirements of the project just by selecting and right-clicking on the desired
transmitter. Different types of transmitter arrangements can be selected in WI depending on
usability. They are: points, routes, circular arcs, rectangular (XY) grids, polygons, circular
cylinders, vertical surfaces and user-defined data files. Fig. 3 shows the list of 15 points where

transmitters are located in the Transmitters tab of WI.
(€8 Wirless Insite - Main: Colleger Area) (G \Trel A0schalsetup 1 N o=

-

Project Edit View Help ‘
D-E-H B @B " | &
[t Featwres | M images | < Studyareas |[3f¢ Transmiters | !y Receivers | 4} Comm.systems | 5 Materials | @ Antennas | J\/\ Waveforns | ¥ Requestedoutput | a Output | il Output fiters
Active | Visible | Description [ Type [ No. points Spacing [ Antenna [ Waveforn | Power | Filename |
Yes Yes t4 points 1 N/A Halfwave di... fivenine 0.00dBm C:\Users\atmel\Desktop\Trial for ASEE\Trial 4\....
Yes Yes t5 points 1 N/A Halfwave di... fivenine 0.00dBm C:\Users\atmel\Desktop\Trial for ASEE\Trial 4\....
Yes Yes t6 points 1 N/A Halfwave di... fivenine 0.00dBm C:\Users\atmel\Desktop\Trial for ASEE\Trial 4\...
Yes Yes t7 points 1 N/A Halfwave di... fivenine 0.00 dBm C:\Users\atmel\Desktop\Trial for ASEE\Trial 4\...
Yes Yes 18 points 1 N/A Half-wave di... fivenine 0.00 dBm C:\Users\atmel\Desktop'Trial for ASEE\Trial 4\...
Yes Yes 19 points 1 N/A Half-wave di... fivenine 0.00 dBm C:\Users\atmel\Desktop\Trial for ASEE\Trial 4\...
Yes Yes t10 points 1 N/A Half-wave di... fivenine 0.00 dBm C:\Users\atmel\Desktop'Trial for ASEE\Trial 4\...
Yes Yes th points 1 N/A Half-wave di... fivenine 0.00 dBm C:\Users\atmel\Desktop'Trial for ASEE\Trial 4\...
Yes Yes t12 points 1 N/A Half-wave di... fivenine 0.00 dBm C:\Users\atmel\Desktop\Trial for ASEE\Trial 4\...
Yes Yes t1 points 1 N/A Half-wave di... fivenine 0.00dBm C:\Users\atmel\Desktop\Trial for ASEE\Trial 4\...
Yes Yes 12 points 1 N/A Half-wave di... fivenine 0.00dBm C:\Users\atmel\Desktop\Trial for ASEE\Trial 4\...
Yes Yes t3 points 1 N/A Half-wave di... fivenine 0.00dBm C:\Users\atmel\Desktop\Trial for ASEE\Trial 4\...
Yes Yes t13 points 1 N/A Half-wave di... fivenine 0.00dBm C:\Users\atmel\Desktop\Trial for ASEE\Trial 4\...
Yes Yes t14 points 1 N/A Half-wave di... fivenine 0.00 dBm C:\Users\atmel\Desktop'Trial for ASEE\Trial 4\...
Yes Yes t15 points 1 N/A Half-wave di... fivenine 0.00dBm C:\Users\atmel\Desktop'Trial for ASEE\Trial 4\...
Selection: t4 [points] Y

Fig. 3. Transmitters window
1.1.5 Receivers

The explanation of the Receivers tab is analogous to that of Transmitters tab.

1.1.6 Materials
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As explained earlier, WI is based on ray-tracing analysis method. Hence, it works by considering
the reflection and transmission of the rays from the buildings, and terrains. This makes the
material types used in the project crucial. Materials tab allows the user to select the types of
material for each items used in the project. This tab is shown in Fig. 4. User can navigate and
change the materials, if required, just by right-clicking on each item.

74 Wireless InSite - Main: (Colleger Area) [C:\..\Trial 4\Nischal.setup 1 L S
eg P

Project Edit View Help

D3| ®(0Rs » & &

P’IY Features 4 Images | <% Study areas ‘>|':' Transmitters ‘”l Receivers ;?;; Comm. systems gj Materials @ Antennas | U} Waveforms V' Requested output | Output E Output fiters
In use l Type l Description ] Feature l Notes I
Yes Dielectric half-space Wet earth Untitled Temain [Temain]

Yes One-ayer dielectric Brick Babcockhall [Object]
Yes One-ayer dielectric Brick Upsonll_Hamingtom [Object]
Yes One-ayer dielectric Brick Gillete [Object]

Yes Dielectric half-space Asphatt_1GHz Untitled Mode! [Object]
Yes PEC Metal ncPontiac98 [City]

Yes Onedayer dielectric PCV nxPontiac98 [City]

Yes PEC Metal nxPontiac98 [City]

Yes Onedayer dielectric Glass xPontiac98 [City]

Yes PEC Metal tx Pontiac98 [City]

Yes Onedayer dielectric PCV tx Pontiac98 [City]

Yes PEC Metal tx Pontiac98 [City]

Yes One-ayer dielectric Glass tx Pontiac98 [City]

Fig. 4. Materials window
1.1.7 Antennas

Antennas and Waveforms (Section 1.1.8) are not only co-related but also are closely associated
with transmitters and receivers used in any project to perform propagation calculations in WI.
Generally, waveform is defined first and then antenna associated with that particular waveform is
defined. All defined antenna(s) are listed in the Antennas tab. This tab facilitates the user to re-
configure the antenna and see its inherent properties by right-clicking on that specific antenna.
Furthermore, antenna should be assigned with TX and RX. WI has several selections of antenna
types’. Antenna patterns can be generated from:
e Built-in models for various common antennas including dipoles, monopoles, helical,
pyramidal horn, apertures, patches, and parabolic reflector
e QGeneric patterns defined by several beam parameters
e Imported patterns from several different antenna pattern data standards including NSMA,
Planet, XFDTD®

1.1.8 Waveforms

Waveforms are essentially the type of signal that is propagated through antenna either from
transmitter and receiver. WI has different types of default waveforms available, e.g. sinusoidal,
and Gaussian waveforms. The other user-defined waveforms can also be utilized. In Waveforms
tab, all the active or inactive waveforms defined by the user are listed. The frequency, bandwidth
and other parameters can be altered simply by right-clicking and choosing from the available
options.

1.1.9 Requested Output

With each project utility, the desired output varies. This tab allows the users to select the
available output options in the WI. They are shown in Fig. 5.
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1.1.10 Output

With this tab the user can access a hierarchical tree view of all currently available output and
graphs. The output data is organized by the study area.

1.1.11 Output Filters

This tab displays a list of active and inactive output filters associated with the project. Output
filters can be used to compute the results using only the rays which have interacted with the
features in specified ways.

#4 Wireless InSite - Main: (Colleger ... = o= S
—————_

Project Edit View Help

Dv2-Ed V@ F's " 8| &~

Il \} Wavefoms || @ Requested output | = Oul ¢ [»

Description

[[] Animated fields

[ Complex Eield

[ Complex impulse response
[[] Delay spread

[] Diagnostic information

[ Direction of amival

] Direction of departure

[C] EMields & Poynting vector
[] Blectric field vs. frequency
[] Electric field vs. time

] Excess path loss

] Free space path loss

[] Free space power

1 Mean direction of amival
[ Mean direction of departure
1 Mean time of amival

[[] Path loss/gain

] Power delay profile
Propagation paths

"] Received power

[[] Temain profiles

] Time of amival

4

Fig. 5. Requested output window showing that the “Propagation paths” is selected
1.2 Project Hierarchy Window
As shown in Fig. 6, the Project hierarchy window is the summary of the entire project. In this

window all the activities are listed in a systematic way. This is one of the powerful options
available in the WI, as it allows the user to navigate within the project and save a lot of time in
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choosing the right procedure. It is, therefore, useful to both novice and experienced users. Project
window can be accessed simply by clicking on hierarchy symbol as shown in Fig.7 or by
clicking View = Project Hierarchy from the menu bar of the Main window.

'E Project hierarchy: (COIE _—

[=)-Project: Colleger Area

| [ Antennas

- Features

Images

- Graphs

Output filters

[)-Receiver sets

B Requested output

- Animated fields
-Complex E-field

-.Complex impulse response

--Delay spread

--Diagnostic information

- Direction of arrival

- Direction of departure

--EM-fields & Poynting vector

- Electric field vs, frequency

- Electric field vs. time

- Excess path loss

-Free space path loss

--Free space power

--Mean direction of arrival

--Mean direction of departure

--Mean time of arrival

-.Path loss/gain

--Power delay profile

- Propagation paths

--Received power

--Terrain profiles

- Time of arrival

[#-Study areas and Output

[#- Transmitter sets

Views

[#-Waveforms

Fig. 6. Project hierarchy window

74 Wireless InSite - Main: (Colleger Area) [CA\.\Trial 4\Nischal setu oo e
ﬁrojed Edit View H

D-&-B ®(Q R &l

ﬂ' Features ‘ !I ImagM'Sludya(eM Transmitters ‘ ‘lh Receivers ‘ ,Qi: Comm. systems E:l Materials ‘ (33 Antennas ‘ W\ Wavefoms Hm‘ = Output ‘ EOuLputfihers ‘

Fig. 7. Project hierarchy and Calculation (RUN) symbols

1.3 Project View

The Project view window is the space in the WI where user applies all the features explained in
Section 1.1. In simple words, Project view displays all currently loaded data. We will discuss the
details about of loading data in Section 2. There are two important menu options (out of many)
available in Project view. They are Edit and View. By clicking on Edit and Preferences, you will
be given options to choose the default values e.g. units of different physical components like
length, frequency, power, default transmitter and receiver height, etc. On the other hand, View
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option will allow you to select between different modes like 2D or 3D, wireframe or solid-body,
and in 3D mode, orthographic or perspective. Fig. 8 shows how a project window looks like.

Project Edit View Output Select Help

lj)@ U A e/ @™ o @~ --wa'mv-)i(—U}l-i e

Ready.

Fig. 8. Project window

1.4 Output Window

Output window displays different requested outputs (Section 1.1.9) related to each study area.
Fig. 9 shows how the output window looks like. The main advantage of Output window is that
user is able to select each branch which is denoted by ‘+’ sign and expand it to select from
available options. Then, user may enter the data just by right-clicking on it.

%A Wireless InSite - Main: (Colleger Area) [.. (sc|n(=laie S
Project Edit View Help

DvE-EH V@R ™ B &

[V Requested output m Output fitters LI_’|

Area: studyarea
[=)-Graphs
=)-K factor vs. Receiver number
TX Rear (#1) --> RX Rear: Propagation paths
K factor vs. Receiver number
=-K factor vs. Distance
t13 (#1) --> r1 : Propagation paths

Fig. 9. Output window

2. Designing a Virtual 3D Object

Remcom® provides some example files (.city, .ter, .obj) and step by step procedure in its
reference manual (which can be accessed by clicking Help on menu bar in both Main and Project
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windows) to use them to learn different aspects and application of the program. However, the
reference manual may not be descriptive enough when it comes to some of the issues related to
building your own environment. This paper will provide easy description to how to design your
own environment and what the key considerations are while doing so. In this section, we have
outlined 7 sub-sections which, in its own way, will guide you to design your own environment.
Later in Section 3 and Section 4, we will discuss about how to attain required information from
the simulations.

The way WI works is well explained in Introduction Section. WI is a handy tool to study the
effects of wave reflection and diffraction on the propagation of waves caused by objects such as
buildings. The first step is to create or construct buildings and other objects as a part of virtual
environment. The location and material properties of these objects should be carefully entered
into the program. In Section 2.1 the process of importing images of maps that are used to create
the buildings is explained. Generation of terrains (shape and material) is explained in Section
2.2. Once the image is loaded and terrain is selected, next task would be either to import the
object files or create your own objects at the exact locations to simulate the real environment.
These are explained in Section 2.3 and Section 2.4. Then the waveform based on the application
requirement should be determined. For example, if path loss in cellular communication is of
consideration, one may select waveform of 1.9 GHz (1900 MHz) sinusoidal signal as carrier
frequency. For easy understanding Section 2.5 explains this step. W1 is also able to evaluate
different communication systems within a certain environment, providing a selection of different
modulation schemes, e.g. Quadrature Amplitude Modulation (QAM), Frequency Shift Keying
(FSK), and Differential Phase Shift Keying (DPSK). However, the communication systems
simulation is not considered in this paper. To complete the simulation the appropriate antennas
system should be selected. WI provides variety of default antennas that are listed in Section 2.5.
TX (transmitter) and RX (receiver) antennas and their locations within the built environment
should be selected that is explained in Section 2.6. Once everything is setup, the final step before
running the simulation would be to select the study area as discussed in Section 2.7.

When you open the WI, always make sure to start with a project name. This is not a mandatory
but it is a good practice in order to avoid any further confusions. To do this, you need to click on
Project menu (which can be found on both Main and Project windows) and then click on New
and give a name in “short description” field. In this paper, we chose the name to be “trial-
inSite”. As any other program, it is always a good idea to save the project file as you proceed
with building your project. File name we chose is “InSite-trial” and it can be different from the
project name.

2.1 Importing Images from Google Maps
Importing images into WI is explained here. The process is broken in to two major steps. Step A
is the procedure that needs to be done prior to importing images into WI and Step B are a few

basic steps that should be done in the WI after the image is imported.

A. Preparation Step
a) Go to https://maps.google.com/ (Your computer needs to be connected to the Internet)
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b) Search the desired location for e.g. “Walmart near Grand Forks, ND” and select the
satellite view for better observation.

c) Check for “Legend” that is generally on the left-bottom side of the website. For example
legend might show 50m/100ft.

d) Crop the image using snipping tool and make sure you include the legend too. Save it to
the appropriate location and then open it with Microsoft-Paint program with ruler option
activated (Fig. 10).

g G

B llnlfllbllulk'?.-B
l::.'
s .l-lnilsl

1

?\
'

v o= ; ~ ~

4 1] Qg 738 x 468px) 100% (=) {} )
~~—

Fig. 10. Walmart area, Grand Fork, ND cropped from Google Maps with legend scale (50m) and opened with Microsoft-Paint

e) Do some mathematical comparison with respect to horizontal and vertical length of the
image. The length of image file is calculated in pixels. As shown in Fig. 10, the blue
circle in the center shows 738 X 468. That suggests, the length of image is 738 pixels and
width is 468 pixels. To import the image into the WI, we need to convert the length in
pixels to length in meters. The red circle in the bottom left corner of Fig. 10 shows the
length of legend, that is, 50m. Two red arrows in Fig. 10 suggest that 50 m in the image
is equivalent to 110 pixels. Therefor, our scaling factor here is 50/110=0.45, i.e. every
pixel in the image, both horizontally and vertically, correspond to 0.45 m.
Since horizontal length equals 738 pixels, the physical length is 738 X 0.45 =335.45 m.
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f)
g)

For vertical length, there are 468 pixels, therefore, the physical length is 468 X 0.45 =
212.72 m.

Check on the properties of the saved image.

Check the resolution, e.g. for the example it will show 738 X 468, which should be the
same as shown in Fig. 10 (blue circle)

Entering Information in WI

a)
b)
©)
d)
e)

g)

Right-click on the Project window (Fig. 11).

Click “Open” and then “Image”.

Select the image file to be imported from the appropriate folder.

Select “Cartesian”.

Enter the physical dimensions you calculated for the image. For example for the image in
Fig. 10 it will be:

X (m) = 33545 m

Y (m) = 212.72 m

Pixel Spacing X (m) = 0.45 m

Pixel Spacing Y (m) = 0.45 m.

Once you enter the values, a reversed image will be loaded to the project window as
shown in Fig. 12.

If you don’t want to operate using reversed image, open the image file in Microsoft-Paint

and go to rotate menu and then click on “Flip Vertical (invert)” and save it. Then, open
this file from WI, as shown in Fig. 13.

{ N
Image properties

Short description:  fwalmart J
Filename: p\Users\atmel\Desldop\TﬁaI for ASEE\
 UTM (¢ Cartesian

Top left comer:
X(m): [335.45
Y {m): |212.72
Pixel spacing X: (m): [0.45

Pixel spacing Y: (m): [0.45
[~ Crop image

OK I Cancel

Fig. 11. Image properties window
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Project Edit View Output Select Help

D @ 7T B Q@ | B 55y B | o

X:502.47m
Y:22410m

Fig. 12. Reversed image in the Project window

Project Edit View Output Select Help

PR DT B @@ 8| o R[5y E | o

X:68463m
Y:275.15m

Ready.

N

Fig. 13. Corrected image after inverting it in the Microsoft Paint (compare with Fig. 10)
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2.2 Creating Terrain

a) Right-click on Project window.

b) Click on New > Features - Terrain.

c) Select “Fit to all features and TX/RX sets and image with padding”.

d) Select “Begin”.

e) Rename it with a short description, e.g. “myterrain”, and leave the default value as it is
and then select “OK” (Fig. 14).

f) Move the four dots to four edges of the image (Fig. 15).

g) Select “Finish”. Save the project again and remember to save it in the same location
where you saved your project file.

Short description: fnytenain J
Longitude subsections: |1

Latitude subsections: |1

Padding at minimum longitude (m): |1 00.0

Padding at maximum longitude (m): |1 00.0

Padding at minimum latitude {m): |1 00.0

Padding at maximum latitude (m): |100.0

0K I Cancel

Fig. 14. New terrain window

it New T
X:145.06 m
Y:63.80m
Carel |

Fig. 15. Editing new terrain
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2.3 Creating Objects

a) Right-click on “Project view” window.

b) Click on New > Features = Object (Fig. 16).

¢) In the bottom of “Edit Object” window, you can see the option of choosing “Material”
Select the material, e.g. we chose brick for buildings, asphalt for road and wood for trees.

d) Once all the materials are selected, right-click on the “Edit object” window again and
select “New component”.

e) Select the outside border of the building you want to include in your project. In this
project we selected some buildings and a road.

f) Once you finish creating the object, you will be asked to assign the height of this object.
In our example, Walmart building height is selected to be 8 m. The road height is
assumed to be 0.001 m (Fig. 17).

g) After creating all the required objects, select “3D” and “Solid body” from “View” menu
option available from Project view window (Fig. 18).

[ Grid spacing (m): [20.0000 Cancel |

Fig. 16. Edit object window
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——
Specify the base and top heights:

Base height (m): 0.000
Top height (m): [3.000

0K I Cancel

Fig. 17. Selecting the object height

Fig. 18. 3D environment with buildings and road

2.4 Importing Objects/City Files

In Section 2.3, we discussed the manual creation of the objects. If we already have a city or
object file, we may import the object from file. As an example here we will show how to import
a car as a “city file”. The key point is to visualize Cartesian co-ordinate system of the imported
image. This is because you now need to do multiple operations of translation and rotation to
place the imported file at the desired location with desired orientation.

a) Right-click on Project view window.

b) Click on Open > Features = City ( you may select object if you need to import object)

c) Select the appropriate city file.

d) Go to Features in the Main window, right-click on recently imported city files then
choose Properties = see the co-ordinates (Fig. 19).

e) Go to Project window again and move the mouse on the location where you want the
object to be located (Fig. 20).

f) Subtract these co-ordinates to get the required relative shift of translation, e.g.
(X:542.66, Y:276.78) — (X: 398.72, Y: 332.87) = (143.94, -56.09).

g) Go to Features in the Main window, choose translate = relative to local origin, and enter
the values, as shown in Fig. 19. Once you do that, you will see a window like Fig. 21.
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Translate relative to local origin

X(m) 14394
Y {m) [56.09

Z(m) |0.00000

[ ok |

Fig. 19. Translation

i

<- Parent Child ->
_<Parent |

(Project: trialinSite) (Building group)

Short description: FxPonliac98 J

Coordinate system: ICattesian LI
Zone: |

Ellipsoid: IWG5.34 LI

Origin longitude: + dec hn(" E

" dms W

Origin lattude: % dec h,(: N

" dms S

Elevations relative to: ITerrain LI

[v Show origin when active
Maximum values {x.y.z): (398.732, 332.87, 1.35486) (m)
Minimum values {xy.z): (357, 328.12, -0.0180554) (m)
Structure-groups: [17

Structures: |17

Sub-structures: |17
Faces: |33
<- Previous I

(Structure: asphaltroad)

[ ok | cCancel |  ppy |

Fig. 20. Co-ordinates of recently imported feature (city files)

264



X:542.66m
Y:276.78m
Z:-0.02m

Fig. 21. The coordinates of location where we want to place the object

Fig. 22. After translation

h) As shown in Fig. 22, the car has been translated to the desired location but the orientation
is not right. So we need to rotate it to a parallel position in respect to the building and
road. Right-click on Project window (since the car is yellow in color that signifies that it
is being selected in the main window). Select Rotate from the list. Select constant z-axis.
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1) Rotate + 90° to bring the car parallel to the building and once you do this you will see the
result like Fig. 24.

-
|About Z |

Point , y. z) {(m):

( [541.806335 . [274.404999 . |0.668405 )
Vector {x.y. z) :

(jo.o . 0.0
Rotation (%)

o

OK I Cancel

Fig. 23. Rotation window

Fig. 24. Object after rotation

1) To import another car that holds the receiving antenna (RX Car), all the steps from (a) to
(1) may be repeated. Another way to do this is using duplicate option as explained in next
step.
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k) Right-click on the object (car) and choose duplicate = translate relative to local origin =
X(m): -15.00 ( leave, Y(m) and Z(m) to its default values). This is just to specify at what
distance you want the duplicate car to be copied, e.g.15 m.

Fig. 25. Duplication and selecting the separation of car (the yellow one is the duplicate car)

2.5 Creating Waveform and Selecting Antenna

Desired waveforms can be created by the following steps: Click on Project > New >
Waveforms, either in Main window or Project window. You may then choose a “waveform type”
from the dropdown menu. In our example we selected “sinusoid”. You will then be asked to
select the frequency (MHz), bandwidth (MHz), phase(°) (Fig. 26). The parameter of waveform
can be manually changed as per experiment requirement.

Short description: mywavefom mywaveform: Time domain

Carrier frequency (MHz): [5900.000
Effective bandwidth (MHz): [10.0000
Phase (): }D_ODDD

Amplitude

OK | Cancel |  Appty |

4e-010

Time (s)

mywaveform: Frequency domain

0
-50
-100
-150
-200
-250

o
=
o
o
=
=
£
<L

-300
5890 5894 5898 5302 5906
Frequency [MHz)

Fig. 26. Waveform creation
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Similarly, desired antenna can be selected by the following steps: Click Project > New —>
Antenna, either from Main window or Project window. You may choose different “antenna type”
from the dropdown menu. In our example we selected half-wave dipole (Fig. 27).

,

Short description: fmyantenna J Polarization: |Total gain v | Edit gain range
Automatic [~ Show max gain amow
Waveform: Imywaveform LI J [~ Render as sphere
Maximum gain (dBi): 7 [Auto
Polarization: | Vertical _ﬂ
Receiver Threshold (dBm): |-250.0000
Transmission line loss (dB): 0.0000
VSWR:  [i00
Temperature (K): [253.00
Edit aray
OK | Cancel |  Apply |
Scalebar properties

Fig. 27. Antenna creation

2.6 Selecting Transmitter and Receiver

Since, we have already created the pattern of the waveform and the antenna, the transmitter or
receiver may now be created. As explained in Section 1.1.4 there are different types of
transmitter and receiver set available in WI. In our example problem we selected “point
transmitter” and “point receiver”. We have assigned three point transmitters located at rear,
center and front section of both transmitting and receiving cars (We have selected the car to the
right of Fig. 25 as a transmitting car and the other one as the receiver). Then we chose a receiver
route, which extends from the rear to the front of the receiving end car. New transmitter set can
be created by choosing Project > New—> Transmitter set = Points. By doing this the project
view will be brought to the foreground. You may want to zoom in or out to get the clear view of
the car as shown in Fig. 28. Now before placing the antenna, try to visualize the location you are
going to place them. The car is 4.75 m long, 1.73 m wide. The height of the center part is 1.35 m.
The rear side is 0.93 m tall and the front side is 0.85 m tall. So, the length wise mid-point will be
1.58 m and the width wise 0.87 m. The ruler option is available in the toolbar in the “project
view” which can be utilized to place the first point transmitter at the center (midpoint). As
shown in Fig. 29, once you place the TX point at the center, right-click will take you to the
“transmitter properties window”. Remember to a give a short description e.g. TX CENTER,
select “myantenna” and “mywaveform” from the dropdown menu on top-right. Also, click on
edit control points, double click on edit vertices and change the value of z to required value i.e. if
antenna is located at the center the height should be 1.35 m. For rear side antennas z= 0.93 m and
for front side z=0.85 m (Fig. 30 and Fig. 31).
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Fig. 28. TX and RX cars

Double-click to edit

X{m)
0

[
0

Fig. 29. Defining the height of the antennas by clicking on editing control points

Transmitter properti
Short description: [TXCENTER =
Coordinate system: |Caneslan ﬂ

I

Origin longitude: ¢ dec #
C dms 7089543780035 cw
Origin latitude: (¢ dec f:ﬁ N
. 6526067522129 s

dms

Elevations relative to: |Te,,am ﬂ
[~ Show origin when active

Antenna: |myantenna - J
Waveforn: [mywavefomn |
Rotate artenma sbout Xaxs () 000

then rotate about Y ads (*): [0.00
finally, rotate about Z axs (*): [0.00
Input power (dBm): 0.0000

A

Antenna viewing options | [ Edit cortrol points | Advanced... |

OK | cCancel | mppy |

Fig. 30. Selecting myantenna, mywaveform and also naming TX center as short description
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TK CENTER

Fig. 31. After 3 point transmitter selected

Similarly you can repeat the step for the receiving end car for selecting receiver points. In this
example, however we chose to use the route receiver. Receiver route can be selected by clicking
Project > New > Receiver set > Route. Route enables us to create multiple point antennas
with user defined direction or routes separated by defined distance, making it easy when the
received power is desired to be visualized along a path. For this example we created a route with
three points (one at the rear, one at the center and one at the front of the car) adjusted to be at the
proper height (Fig. 32 and Fig. 33). Since we have selected the spacing to be 0.5m, it
automatically creates as many receivers that can exist between those points with spacing of

0.5 m. In this case, there were 8 receivers. This number can be viewed in the receiver tab in the
Main window. After creating route, it looks something like Fig. 34.
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Double-click to edit
X {m) LY m) [ Zm)
0 0 0.9300
-1.4147 0 1.3500
-3.3777 0 0.8500

[ ok |

Cancel

Fig. 32. Selecting three points of the route at the receiving end with their locations(x, y) and heights(z)

Zone:

Ellipsoid

Fotation ]

Short description:
Coordinate system:

Origin longitude:

Origin latitude:

Elevations relative to:

.
]

fmyroute J Antenna: |myartenna hd
I Cartesian LI Wavefom: | mywaveform hd
I Rotate antenna about X axds (°): [0.00
[Wasea =] then rotate about Y axis (*): [0.00
finally, rotate about Z axis (*): {0.00

((f 9eC [1519593656105 ; E d 0-p

dms w Input power (dBm) |N,-"A
@ dec permaes - N
" dms duleiis s Spacing (m): }0500000
ITenain LI

[~ Show origin when active

o-00

Antenna viewing options I Edit control points I Advanced... |
oK | Cancel |  Apply |

Fig. 33. Selecting myantenna and mywaveform and also editing short description field

Fig. 34..TX car with 3 transmitting point antennas and RX car with one route (with 3 points and 8 receivers)
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2.7 Creating Study Area

Study areas have several purposes. They make it possible to specify for the software to only use
a subsection of the buildings and terrain data in the calculations. This guarantees that buildings,
terrain faces, receivers and transmitters outside of the study area are not included in the
computations. This feature allows WI to load a large set of features but restrict the calculations to
a smaller subset, saving considerable computation time. Creating a study area is similar to
creating a transmitter or receiver route. First, activate the Main window and choose Project

- New = Study area. Then choose between the option to automatically fit the study area
around all the loaded features and TX/Rx locations, or the option to specify the boundary
manually.

3. Running Simulation

Choosing New from the Run menu will activate a new calculation log, producing the results that
are selected in the requested output checklist. Going to Edit, and clicking on Preferences to select
default values for each activity sometime makes things easier while viewing output. To see the
output results better the followings might be considered:

e Propagation model can be selected by right-clicking on study area and selecting
properties. Also to speed up the process, go to study area properties and select

No. of Reflection = 8
No. of Transmission = 2
No. of Diffraction = 1

272



— v-‘ - -
“4 Wireless InSi... (5=m(n=] l Calculation log: (trial-i

Project Edit View Help triakinStte
~ [ 90 Percent Completed 0Oh Om 0Os
DrE-Ed @@ k| 100 Percent Completed Gh Om Os
I [V Requested output ‘ w? O 4 | » Transmitter set: tx front
to Receiver Set: 5
— 10 Percent Completed Oh Om 0s
Description 20 Percent Completed 0h Om Os
. . 30 Percent Completed 0Oh Om Os
Animated fields 40 Percent Completed Oh Om 0Os
Complex Eield 50 Percent Completed Oh Om 0s
. 60 Percent Completed 0Oh Om Os
Complex impulse response 70 Percant Completed Oh Om 0s
Delay spread 80 Percent Completed 0h Om 0Os
Diagnostic information 1%2?;:&%’:‘“9;;6; %’1 06,“11 06‘8
Direction of amival
Direction of departure Completed writing movie files
EMields & Poynting vector Completed writing path records
v ic fi .
Eledr?c f!eld vs frequency Completed writing 3d dpath records
Electric field vs. time
Excess path loss Completed writing 3d path records
Free space path loss Completed writing field records
Free space power
Mean direction of amival Timing results for study area studyarea
Mean direction of departure
. . Searching for First Order Diffracting Edges: 0h 4m 25s
Mean time of amival Searching for Paths: Ch 18m 155
Path loss/gain (Slombirzfr;g l-?qelds _Fnd Wg:nZQ ﬁu%ﬁm: 0Oh Om 29s
Power delay profie tudy Area Run Time: s
Propagation paths Finished
Received power
Termain profiles Waming Messages
Time of amival None
P Stop time: 16:28:51 7/15/2013
< UL » Flanead time: 22 minitee 14 carnnde

< | 1

Y Calculation finished. Elapsed time: 23:14 Y

() (i)

Fig. 35. (i) Requested output, (ii) Calculation log

4. Viewing Output and Results

All the available outputs are shown described in Fig. 36. Figs. 37-40 show some of the results in
a graphical form. The viewable output of any project depends on the items checked in the
requested output tab of WI. As explained earlier, WI provides definite of output which is good
enough to study the propagation characteristics of the created virtual system. Each user may have
its own requirement to exploit these features. Path loss, Received power and phase, Propagation
path, Power vs. Delay (Time of arrival) are common properties to be explored. In this section, we
will study about the procedure to see output and the considerations in viewing them. The
consideration for some specific outputs are:
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A. Pathloss: Click on ‘+’ sign on the pathloss available in the output tab (Fig 36.). Doing,
this, WI will show all the transmitters included in the project. Since we have 3
transmitters in out example, it will show TX CENTER, TX REAR, and TX FRONT. This
allows the user to choose the receiver response with respect to each available transmitter.
If you click on any transmitters, it will show the receiver list. Since, we have selected a
route receiver (my route) it will display only “myroute”. To plot, just right-click on my
route and select plot and select number of receivers to see the pathloss graph. The process
of viewing Pathgain is almost the same. The result is shown in Fig. 37.

B. Received power and phase: Click on ‘+’ sign on the “received power”. Chose the
transmitter then choose the receiver. Right-click and select the plot and the receiver
number to see the received power at different receivers with respect to selected
transmitter. However, to know the phase of the received power, right-click and select
“open” instead of plot. This will open a text file with receiver antenna location with its
respective received power and phase. The result is shown in Fig. 38.

C. Propagation path: Click on ‘+’ sign on the Propagation path. Click on the desired
transmitter. Right-click on the receiver type. In our case the type is route. Once you right-
click on it, you will see various options to view the propagation path. The best way is
“load”. This will create an extension of ‘+’ sign. Click on this sign to see the path for
respective receiver. The propagation path can be viewed in the project window by right-
clicking on the receiver and clicking view. There is another option called “play”. This
will allow you to trace the rays shot from the TX to RX. The color of rays denotes its
strength. This can also be recorded in a video files. Also, by right-clicking on the desired
receiver and clicking on “plot” one can see the K- Factor, which is the ratio of direct path
to the diffused path. The result is shown in Fig. 39, in the Non-Line-of-Sight (NLOS)
cases.

D. Time of arrival: This function yields Power vs. Delay graph. The process is similar to C.
The difference is that you need to select “plot” when you right-click on the receiver. The
result is shown in Fig. 40.
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Fig. 36. Output tab (which can be accessed through project hierarchy)
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Path loss vs. i
— TXCENTER (H1) > myroute : Path los: Path loss vs. Receiver number
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Fig. 37. Pathloss (dB) vs. receiver number

— TXCENTER (#1)--> myroute : Received power Received power vs. Receiver number
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Fig. 38. Power(dBm) vs. receiver number
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FAIETES

X:661.71m

Y:27562m
544 com RIS

Selection: TX FRONT [points]

Fig. 39. Propagation path from TXCENTER to receiver (myroute)

Power vs. Delay for Rx point 1

=+ TXCENTER [(H#1]--> myroute : Time of arrival (Rx point 1) Power vs. Delay for Rx point 1
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Fig. 40. Power vs. delay (TXCENTER and RX1 of myroute)
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5. Discussions and Conclusions

WI can easily be used for teaching wireless propagation and effects of objects and terrains on the
propagation and communication. In this paper, step-by-step instructions for building and
simulating the environment under study in WI is explained. Several examples might be built
using these easy instructions to be included as laboratory assignment in the related course such
as wireless communications and antennas and propagation. Various parameters such as pathloss,
degree of arrival, degree of departure, power, propagation path and power delay profile may be
extracted from the simulations and use them to explain different propagation and communication
phenomena.
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